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Introduction 
The Unity Softphone (Business Communicator) allows you to interact 
with the LSE phone system from your PC. You’ll be able to accept 
calls, make calls and change settings such as call forwarding options 
and remote office without having to touch your desk phone, or have the 
Telephony Toolbar software running on your computer. 

Please note that the exact options and features available will vary depending on 
your service pack licence. Contact telecoms@lse.ac.uk for advice on the service 
pack you are assigned. 

INSTALLATION 

To install the software, please visit the Softphone download and installation 
page on the LSE website.  
 
Windows 
• Double-click the installer executable and follow the installation 

instructions. 
• Launch Unity. 
 
OS X 
• Double-click the disk image. 
• Copy the application into the Applications folder. 
• Launch Unity. 

 

Acknowledge any warnings following the install prompts. You can accept all defaults. 

LOGGING IN 

 

When you first launch the application, you are prompted to sign in. 
 

1) Enter your Unity user name and password. 
 

2) Select whether you would like Unity to remember your password. 
 

3) Select whether you would like Unity to sign you in automatically on 

subsequent launches. 
 

4) Click Sign In. 

 

 

Enter your username and password. 

Username: Your LSE email address. For 
example:  A.N.Other@lse.ac.uk 

Password: Your Telephony Toolbar password. 
This will have been emailed to you directly by 
the Telecoms team upon migration to the new 
telephony system. If you are unsure, please 
contact telecoms@lse.ac.uk 

When you have entered all of your information, 
click the Sign In button to begin using the 
Softphone application. 

 

mailto:telecoms@lse.ac.uk
mailto:A.N.Other@lse.ac.uk
mailto:telecoms@lse.ac.uk
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My Information – View and 
update your information, for 
example, your presence, 
avatar, and location. 

 My Room – This is your 
permanent communication 
room. Participants can dial in to 
your audio bridge. 

 Contacts – View your contacts. 

  

Communications History – 
View previous chats and calls. 

  
Full Enterprise Directory – 
Show all contacts of the 
directory. 

 
Dial Pad – Make calls, it is 
integrated with the main window. 

  
Chat – Start an instant message 
conversation with a selected 
contact. 

 Call – Make an IP audio call to a 
selected contact. 

  
Call from Phone – Make a 
Click-To-Dial call from your desk 
phone (or secondary device). 

 Video Call – Make a video call 
to a selected client (VoIP). 

  
Menu – Open Call Settings, 
Preferences, and Help. 

  
Call settings menu– Use for 
quick access to call settings 
such as call forwarding. 

  Add – Add a contact, group, or 
conference. 

  

MAIN WINDOW 

 

When you start Unity the first time, your Contacts list is empty. Use the search field to find 
people and add them to your Contacts list. Contacts can also be added manually by 
clicking the Add button. Client windows can also be set to be always using the main 
window menu option.  
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PRESENCE 

 

You can set your presence to one status indicated in the following table. 

 

 

 

Unity can automatically update your presence to the following: 

 

 Busy – In Call 

 Busy – In Meeting (Windows only) 
 

MAKE AUDIO OR VIDEO CALL 

 

Make an audio or video call using one of the following methods: 

 

 Left-click one or more contacts from the Contacts list or search results and click 
the Call, Call from Phone, or Video button. 

 

 Right-click one or more contacts from the Contacts list or search results and click 
the Call, Call from Phone, or Video. 

 

 Enter a phone number in the Search and Dial field. 
 

 Press ENTER to start a VoIP call. 
 

 Click the Call, Call from Phone, or Video button. 
 

 Open the dial pad, enter a phone number, and then click the Call, Call from 
Phone, or Video button. 

 

 On the Communications History list, double-click a call entry. 
 

 In the Communications window, click the Call, Call from Phone, or Video 
button. 
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 When viewing a contact’s profile, click the Call, Call from Phone, or Video 
button. 

 

 
 

Call    Call from phone        Video call 

 

 

 

 

 

 

 

Select Audio Devices 
 

If you have multiple audio devices available for your microphone or speakers, 

select the preferred audio device before starting a call. 
 

Windows 
 

1) Click the Unity logo in the main window title bar. 
 

2) Select Preferences. 
 

3) Select Audio. 
 

4) Set a playback device (speakers). 
 

5) Set a recording device (microphone). 
 

6) Click OK. 

 
OS X 
 

1) Select Unity from the main menu. 
 

2) Select Preferences. 
 

3) Select Audio. 
 

4) Set a playback device (speakers). 
 

5) Set a recording device (microphone). 
 

6) Click OK. 
 

If “Use default” is selected, then Unity uses the default device set in the operating 

system preferences. For Windows, if “Default Communication Device” is defined, 

it is selected over the “Default Device”. 
 

If you are using headsets, you can also select a separate device than the 

headset for alerting incoming calls. 

 
NOTE: If dialling a phone number that requires additional dual-tone multi-frequency (DTMF) 

 
tones (for example, a conference bridge), you can type the numbers on your keyboard while the 

 
Communications window has focus or open the dial pad in the Communications window. 
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CONTACTS 

 

Contacts are the people with whom you communicate and, in most cases, you 
see their presence and share your presence with them. There are three types 
of contacts: 

 

 Contacts – Actual people with whom you communicate. 
 

 Conferences – Audio or video conference bridges that you use to 
communicate with others. Silent dialing into the bridge also applies to 
these contacts if enabled by your service provider. 

 

 Groups – Containers of contacts and/or conferences. 
 

Add 

 

When you sign in for the first time, there are no contacts on your contact list. 
Add a new contact at any time by selecting the Add Contact item from the 
menu or choose the Add Contact button from the main window. 

 

In the Add Contact dialog box, enter the contact’s information and then click 
Add Contact. By default, your presence information is always shared with a 
new contact if an Extensible Messaging and Presence Protocol (XMPP) 
address is provided. 
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If you are accepting contacts via a buddy request, you may see the contact 
card after accepting the buddy request, depending on the service provider 
settings. 

 

However, you can always share your presence information later by selecting 
Subscribe on the menu for that contact on the contact list (right-click the 
contact or arrow button). Note that the contact must accept your subscription 
request for you to establish the presence relationship successfully. 

 

The newly added contact appears on your contact list. 

 

Add a conference contact by clicking the same button you did for Add contact 
and choosing the Add conference menu option. A conference contact is a 
special contact used for conference bridges to avoid remembering PIN codes 
and conference number, for example, recurring conferences. Just create a 
contact for the weekly conference, add a conference bridge number and PIN, 
and join the conference just by right-clicking the contact or choosing it and 
clicking the Call button. 

 

Choose the Add group menu option to add a new group to the contact list. 

 

Edit 

 

Edit a contact by selecting the contact first. After you select the contact, right-
click anywhere in the area of the selected contact and a menu of options 
appears. This base principle is the same for normal contacts, conference 
contacts, and groups. Note that depending on your service provider settings 
all or no contact card fields may be editable. Depending on your service 
provider settings, you mayalso see a button for synchronizing the contact card 
with the Telephony directory or the synchronization may take place 
automatically. When the manual synchronization button (cloud icon) is visible, 
there is no automated syncing of the contact card details with server 
information. To synchronize the contact card data, click on the cloud icon. 

 

 Unsubscribe removes the presence relationship between you and 
that contact. This means you do not see the contact’s presence 
information and your contact does not see yours. To re-establish the 
presence relationship, select Subscribe. An unsubscribed contact 
remains on the contact list and is always shown without an icon. Any 
contact that is not presence-enabled is shown in the same way. 
 

 Remove removes the contact from your contact list. 
 

 View Profile opens the Contact Information dialog box where you can 
add, edit, or remove information. This works for both normal and 
conference contacts. 

 

 For groups, choose the Edit menu option to rename a group. 
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Filters 

 

You can filter contacts in two ways: 

 

 Use the filter field to search by contact name. The contact list is 
filtered in real time as you type. 

 

 Alternatively, use the filter menus available by right-clicking the 
Contacts icon in the left pane to display only specific types of contacts 
such as favourites or online contacts. You can also sort contacts 
based on first or last name or choose whether to display the contact’s 
avatar and availability status in the contact list. 

 

AUDIO AND VIDEO CALLS 

 

The following table describes additional Communications window icons and 
explains what you can do with them, for voice and video calls. 

 

 

 

In the Options menu, there are the following options: 
 

 Transfer a call to a third party. 
 

 Put the call on hold. Note that if you hold the call, the other party cannot 

“un-hold”. This freezes a video call to the last frame of the video feed. In 

both voice and video calls, this is communicated to all parties by a 

notification appearing in the middle of the screen. 
 

 Hide your own video. 
 

 Add participants to the call. 
 

Dial a number in the combined Search and Dial field to make a call. Once you 

type your numbers, Unity searches for contacts on both the local contact list and 

the enterprise directory. 
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Choose your video size from the Preferences and the Video tab. Your selection is 

used by default for future video calls. The available sizes are automatically 

presented based on your camera. The selected video size can be modified 

automatically depending on your CPU load and changing network conditions to 

optimize the video quality. 

 

Call From Computer 

 

Select a contact from your contact list to start communication and click the 
desired communication button. Type a phone number in the Search and Dial 
field at the top of Unity window (search or communicate), to communicate 
with someone who is not on your contact list. 

 

Call From Phone 

 

The second option to communicate in the row of communication buttons is the 
Call from Phone. When you click this button, the desk phone instantly starts 
ringing and the call is established from your desk phone. This depends on 
your service provider configuration as other devices mayalso ring. 

 

For remote calls initiated using the Unity, you can also have mid-call controls 
such as hold/resume, transfer, and add participant. 

 

Automatic Busy – In Call presence also works with the Call from Phone 
feature. 

 

Answer Call 

 

When someone is calling you, you see a pop-up notification on your screen. 
You can choose to answer, silence the incoming call, and then open a chat 
session with the caller, reject the call, or silence the incoming call by closing 
the popup notification window. If you silence the call, the ringtone is silenced 
but the caller does not see anything on their end. You can answer or reject 
the call after silencing it only if you have chosen the chat option. If you close 
the incoming call pop-up notification to silence an incoming call, then you do 
not have an option to answer or reject it any more. When choosing the chat 
option, chat is only enabled after the call has been answered or rejected. 

 

If you reject the call, it causes the line to sound busy at the caller’s end and 
they know that you rejected the call. 

 

When someone is calling you with a video, you see the same pop-up 
notification; however, the options are answer with video, answer as voice 
only, silence and chat, reject, or silence (by closing the popup window). If you 
decide to answer as voice only, the call is voice only. 
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Contact Name Lookup for Incoming Calls 

 

Whenever the incoming call does not have a calling name associated with it, 
Unity can perform a local contact search. If the number matches one of the 
contacts on the Unity contact list, the name is shown on the incoming call 
screen along with the alert. 

 

Whenever you retrieve your call logs/history and the call log does not have a 
calling name associated with it, Unity does a lookup in the local contacts and 
populates the name if a match is found. 
 

Missed Call or Communication 

 

When you have one or more missed calls or other types of communications, 
there is a notification on the left-hand side of the navigation pane in the main 
window. Clicking the icon takes you to the missed communication in the 
Communications History view. 
 

Full Screen in Video Call 

 

Full screen mode can be activated by clicking the Full Screen button or by 
double-clicking anywhere on a video. 

Exiting full screen mode is done by pressing the ESC keyor the Windows 
button. Exiting full screen makes the video call go back to its original state 
(even if there was resizing of the window previously before going full screen). 

 

In a full-size window, you can see a similar Options menu at the top. It has the 
same functionality as it does in the normal view. When you move the mouse, 
the top bar and lower communication buttons appear on top of the video. 

Multiparty Sessions 

 

You can have manyparticipants in a call, either in an ad hoc multiparty call. 
Add more participants by dragging and dropping them on to the 
Communications window or by selecting the Conference menu item via the 
Communications window menu button. By choosing the menu item, you can 
also add participants with just a telephone number. 

 

Voice conferencing does not use a bridge but instead uses the Unity N-Way 
Calling supplementary service in a sequential fashion. 

 

Call Waiting 

 

You can have one active call at any one time if you receive a new incoming 
call and accept it. The existing call is put on hold and you can change 
between these two calls by using the Hold and Unhold buttons. 

 

Call Transfer 
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Blind call transfer is available in the Communications window; choose the 
Transfer Call menu item to transfer the call to someone else. Attended call 
transfer is also available in the same window, first call someone to check if 
the called party can take the incoming call and then transfer the incoming call 
to the desired called party. 

 

Message Waiting Indication and Voice Mail 

 

The Message Waiting Indication (MWI) service allows you to receive a 
notification for a waiting voice mail or video mail. By clicking on the message 
icon in the upper right-hand corner of the main window, Unity calls the 
predefined mailbox number to allow the user to listen to the voice mail or view 
the video mail. 

 

It is also possible to call voice mail from the dialler by long pressing the “1” 
icon in the dialler. 

 

Missed calls are indicated by an icon in the main window. Missed video and 
audio calls are indicated with a different icon. Note that the MWI icon is in the 
same place when it indicates a new voice mail. 

 

Call Park and Retrieve 

 

Call Park is particularly suited for shared environments where one person can 
answer the call, park it, do something else for a while and continue the call 
from another device or let somebody else continue the call. 

 

Transfer an on-going VoIP call to a Call Park server and then retrieve it when 
needed. An on-going call can be parked against your own number or another 
number (an extension). Call Retrieval works in the same way, the parked call 
can be retrieved from your own number (an extension) or another number (an 
extension) to provide flexibility for who is picking up the parked call. 

A parked call is visible on your desktop in the active communications area so 
that you can easily retrieve it, but only for the duration of the Unity Call Park 
announcement. After the announcement is over, the parked call disappears 
from the active communications area (since the triggering call is 
disconnected). After the call disappears from the active communications, the 
user has to remember the extension to which the call has been parked to 
retrieve it using the main window menu (or feature access code), unless the 
call was parked to the one’s “own” extension. If the call is not retrieved after a 
certain time, then the server calls the parking user. 

 

Call Pull 

 

Call Pull allows you to pull an on-going call from one of your devices to 
another one where the Call Pull feature is used. Call Pull can also be used 
with feature access codes (FAC), in this case, *11. In this release, user 
interface support has been added to the desktop so that an end user does not 
have to remember feature access codes. 
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Headset Support 

 

You can control incoming and on-going calls from a compatible headset. The 
feature set supported is answer/hang up as well as mute/unmute and volume 
up/down. The following Plantronics headsets have been tested, although 
other Plantronics devices should also work: 

 

 Voyager Pro UC 
 

 Savi 700 series 
 

 Blackwire C3xx, C4xx, C5xx, and C7xx 
 

 Calisto 620 
 

 Audio 628USB 
 

 

Search 

 

Unity supports a search of the enterprise directory. This takes place in the 
same search field that is used for both a local and presence-enabled contact 
list search. 

 

Unity automatically searches the local contacts and presence-enabled contact 
list in addition to the enterprise directory at the same time. As soon as there 
are results from the enterprise directory, these results are shown on a 
separate list in the main window. Additionally, there maybe other search result 
groups from other search sources such as Lightweight Directory Access 
Protocol (LDAP) or Outlook. 

 

Search results are displayed differently depending on the results of the 
contact list and directory search: 

 

 If LDAP search (Corporate directory) or Outlook search are enabled, 
there are more result groups. 

 

 If there are no results for a certain search source (local contacts, 
Outlook, LDAP, or Unity telephony directory) that group is different in 
the user interface (UI). 

 

The enterprise directory searches all available fields for the search string. By 
default, it waits for 1.5 seconds before it sends the search request to the 
server to minimize unnecessary load on the server. 
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Typically when adding a contact using directory search results, there are 
phone numbers and first names in addition to last names available.  

 

LDAP search (Corporate directory) needs to be enabled by Redcentric. In 
addition, you must manually provide your LDAP credentials in the 
Preferences → Security tab. LDAP search results are provided in the 
corporate directory group in the search results. 

 

Outlook integration (search and calendar integration) on Windows requires 
one of the following versions installed on the desktop: 

 

 Outlook 2007 
 

 Outlook 2010 
 

 Outlook 2013 
 

Outlook search also works when several Outlook accounts are in use, but 
only one account is used at a time (default selected, which can be changed in 
Outlook). Additionally, other related considerations are as follows: 

 

 The client searches for contacts and calendar entries in the default 
Outlook account. The account is set to the default via File → Info (left 
pane) → Account Settings → Account Settings → Data Files. Select 
an account and mark it as “Set as Default”. After making this change, 
sign out and sign back in to the client and it now searches that 
account for contacts and calendar entries. 

 

 The client searches the Outlook contacts only on the local machine 
(that is, the Outlook Address Book). There is no Exchange server 
lookup performed. In addition, all directories in Outlook are searched 
for contacts, even deleted folders. The Contacts directory can also 
have multiple levels of subfolders. 

 

 

 

Every minute, Unity reads Outlook appointments. If there is an appointment 
running at the current time, then the presence is shown as Busy – In Meeting. 
Overlapping appointments are also handled. Following are some examples of 
Unity operation with Outlook when time is 9:10 A.M 

 There is meeting “A” 9 A.M. through 10 A.M. Presence is shown as 
Busy – In Meeting. 

 

 Presence is explicitly changed to Available at 9:15 A.M. Presence is 
shown as Available. 
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 In the next minute, Unity again reads the appointments and sees that 
“A” meeting is running; however, the presence was already explicitly 
marked as Available and presence is not shown as Busy – In Meeting 
but Available. 

 

 There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M. 
Presence is shown as Busy – In Meeting when the time is 9:30 A.M. 

 

When deleting a meeting that is currently on-going in Outlook, the presence 
status remains as Busy – In Meeting until the next time Outlook appointments 
are checked (once every minute) and after that, presence is shown as 
Available. This change may be instantaneous or it may take a minute 
depending on how close the timer is to being triggered. 

 

The Outlook Object Security model was introduced in Outlook 2007. It has 
been tested with Outlook 2010 and Outlook 2007. For Outlook versions prior 
to 2007, the Allow/Deny pop-up window seen in previous releases should not 
be triggered. However, those versions are not officially supported. For 
Outlook 2013, the behaviour should be similar to 2007 and 2010, meaning the 
popup should not come up with Outlook 2007, 2010, and 2013. However, 
more tests are needed for this before official support for Outlook 2013 can be 
declared. 

 

The presence update is only triggered by appointments and meetings that are 
either accepted by the user or made by them. All-day meetings do not trigger 
a presence change to Busy – In Meeting. 

 

Full Enterprise Directory 

 

Unity allows for the browsing of an entire Redcentric enterprise directory. 

 

To view the Redcentric enterprise directory, click the Directory button on the 
left-hand side of the navigation pane (if available). This feature depends on 
the Unity service configuration so it may not be visible in all clients. 

 

Communications History 

 

The second icon from the top in the main window on the left-hand side of the 
navigation pane displays your messaging history. Double-clicking a 
conversation on the list opens it in a new window. 

 

Unity saves a call history for placed, received, and missed calls. The call 
history makes it easy for you to redial and call back when you have missed a 
call or you want to easily dial a contact with whom you have recently spoken. 

 

Double-click on a name in the list to call back directly (this calls back the 
same way you previously spoke, for example, if you were in a video call, 
double-clicking starts a new video call). Double-clicking an incoming call item 
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from presence-enabled contacts opens a chat window, from which a call can 
also be made. 

 

To clear the missed chat indicator, you need to open the missed chat. 

 

The Communication History missed communications badges can be cleared 
by using the right-click menu from the Communication History button on 
left-pane. The menu provides options to clear “All missed”, “Clear missed 
chats”, and “Clear missed calls”. 

 

 

 

PREFERENCES 

 

Preferences provide access to available settings for Unity. Follow these steps 
to access Preferences. 

 

Windows 

 
1) Click the Unity logo in the main window title bar. 
2) Select Preferences. 
 
OS X 
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1) Select Unity from the main menu. 
2) Select Preferences. 
 

Language 

 

Select your language then click OK or Apply and the change takes effect 
immediately. Note that the number of languages depends on your service 
licensing. 

 

Log In 

 

Enable or disable automatic sign-in when starting the application. 

 

Confirmations 

 

Usually there is a confirmation pop-up notification each time you remove a 
contact or call history record. By selecting one or all of the check boxes, you 
disable the confirmations when deleting information. Here you can also 
control whether there always is a pop-up notification for publishing location 
information. Typically, this is shown at login. 

 

Logging 

 

Logging is used for troubleshooting. You may be asked by Redcentric to turn 
on logging and then send a log file directory. 
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AUDIO 

 

Output Device (Speakers) 

 

Choose a headset, PC-integrated speakers, or external speakers for audio 
output. Your external playback device is selected by default (if you have one 
connected). 

 

Voice Recording (Microphone) 

 

Choose a headset microphone, PC-integrated microphone, or external 
microphone for voice during calls. Your external recording device is selected 
by default (if you have one connected). You can also choose automatic gain 
control and test your recording device. 

 

Alert Signal 

 

Select the audio device and ring signal that is played when you receive an 
incoming call. The same signal is used for both voice and video calls. You can 
also select your own ring signal. 

 

Sounds 

 

Select which events cause a notification sound. To disable the sound, 
uncheck the check box. Select a sound event and then click Play to hear the 
sound. 

 

VIDEO 

 

Capture Device 

 

Select a camera that you want to use for video calls. Your external web cam 
is selected by default (if you have one connected). 

 

Video Size 

 

Select one of the available sizes. Note, however, that higher sizes require 
more bandwidth and a more capable central processing unit (CPU). 
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PROXY 

 

Proxy Settings 

 

Select how to handle HTTP proxies. By default, the system settings are used 
but you can also choose not to use an HTTP proxy or to use the Unity (client) 
proxy settings. 

 

CALL SETTINGS 

 

Unity supports the following service management features allowing 
supplementary services to be managed using the native Unity Call Settings 
window: 

 

 Unity Anywhere 
 

 Unity Remote Office 
 

 Call Forwarding 
 

 Do Not Disturb 
 

 Hide Number (Calling Line Identification Presentation [CLIP]/Calling 
Line Identification Restriction [CLIR]) 

 

 Simultaneous Ring Personal 
 

You can also use the call settings with a Main Window on the top of the 
window, if this feature is enabled. When enabled, this feature allows Unity 
Anywhere, Do Not Disturb, Remote Office, and Call Forwarding to be 
managed in the Main Window using single clicks or right clicks. 

 

Unity Remote Office 

 

This service allows the use of any phone as the office phone from a charging 
and numbering perspective. For instance, a hotel room phone can be used as 
the office phone. 

 

Enable Remote Office by clicking the Edit icon and specifying a phone 
number to be used as the Remote Office number. 

 

Forward Calls 

 

Enter a number to which your calls should be forwarded. Different variants of 
call forwarding are supported, such as forwarding always, forwarding when 
busy, and forwarding when you cannot answer or when you are unreachable. 
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Do Not Disturb 

 

When you activate this service, all calls are typically blocked by the server 
and sent to voice mail. Enable this service by clicking the Enable check box. 

 

Hide Number 

 

You can hide or display your number when calling or communicating with 
other parties or contacts. Hide your number byclicking the Enable check box. 
To show your number, set this to “Disable”. 

 

Simultaneous Ring Personal 

 

Add up to ten additional numbers or Session Initiation Protocol Uniform 
Resource Identifier (SIP-URI) addresses that you would like to ring in addition 
to your primary number when you receive a call. In addition, specify whether 
you want answer confirmations.  

 

 

 

SIGN OUT 

 

Signing out of Unity sets your status to “Offline” for your contacts and displays 
the Sign In screen. 
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Sign Out of Unity 

 

To sign out, follow these steps. 

 

Windows 

 

1) Click the Unity logo in the main window title bar. 

2) Select Sign Out. 

 

OS X 

 

1) Select Actions from the main menu. 

2) Select Sign Out. 

 

Exit Application 

 

To exit the application completely, follow these steps. 

 

Windows and OS X Close the Sign In window. 

 

Windows 

 

1) Select the Unity logo in the main window title bar. 

2) Click Exit. 

 

OS X 

 

1) Select Unity from the main menu. 

2) Select Quit Unity. 

 

 

NOTE: Closing the main window (not the Sign In window) 
does not exit the application but 

 

rather minimizes the application to the system tray (Dock). 
This allows you to continue to 

 

receive calls and messages without having the Contact List 
window appearing on the desktop. 
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KEYBOARD SHORTCUTS FOR DESKTOP 

 

The following table lists the currently supported keyboard shortcuts. You can 
use these keyboard shortcuts to quickly perform frequently used actions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



Version 1.2 Softphone User Guide for MAC & Windows 

 

21 

 


